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Валентин ВОЛОДИН

Коротко о SPICE

В настоящее время наибольшую популяр-

ность имеют программы, использующие

SPICE (Simulation Program with Integrated

Circuit Emphasis) алгоритм моделирования

процессов, протекающих в электронных

схемах. Алгоритм SPICE, разработанный

в конце 1970-х годов в университете Беркли

(Калифорния), де-факто стал стандартом для

разрабатываемых и уже эксплуатируемых

в настоящее время коммерческих систем схе-

мотехнического моделирования для персо-

нального компьютера. К таким системам от-

носятся: HSPICE (фирма MetaSoftware), PSpice

(Microsim), MicroCap (Spectrum Software),

Circuit Maker (The Virtual Elektronics Lab),

Dr. Spice, ViewSpice (Deutsch Research) и дру-

гие. Учитывая тот факт, что не все могут при-

обрести коммерческую систему схемотехни-

ческого моделирования, остановим свой вы-

бор на бесплатном симуляторе LTspice IV

(далее просто LTspice) от корпорации Linear

Technology (www.linear.com). Программа мо-

жет работать под управлением ОС Windows 98,

2000, NT4.0, Me или XP. Кроме того, LTspice

тестировался под Linux RedHat 8.0 с WINE

версии 20030219.

LTspice был первоначально основан на си-

муляторе аналоговых схем SPICE 3F4/5, сво-

бодно доступной версии симулятора SPICE.

С момента своего создания LTspice подвергал-

ся постоянным изменениям с целью его улуч-

шения, устранения ошибок и расширения

возможностей. Современная версия LTspice

представляет собой превосходный симулятор,

позволяющий моделировать аналоговые, ци-

фровые, а также смешанные схемы.

LTspice отличается очень понятным и дру-

жественным интерфейсом, позволяющим да-

же новичку очень быстро научиться работать

с ним. Новые схемы можно разрабатывать с по-

мощью встроенного редактора схем. Директи-

вы и параметры симулятора помещаются пря-

мо на схеме с использованием стандартного

SPICE-синтаксиса. Диаграммы напряжений

и токов в узлах и ветвях схемы могут быть по-

лучены простым щелчком левой кнопки мыш-

ки по соответствующей точке схемы.

LTspice имеет отличный (правда, англо-

язычный) встроенный помощник Help [1],

который является как описанием этой про-

граммы, так и руководством для работы с ней.

В Интернете существует много ресурсов, где об-

суждается и поддерживается эта программа [2].

Необходимость пополнения 
библиотеки моделей

Симулятор LTspice изначально предназна-

чался для демонстрационного моделирова-

ния импульсных источников питания, ис-

пользующих управляющие микросхемы про-

изводства Linear Technology. При этом LTspice

демонстрирует приличную скорость модели-

рования и оптимальную совместимость

с другими стандартами SPICE, что позволя-

ет непосредственно использовать или легко

адаптировать к нему оригинальные SPICE-

модели различных производителей. Послед-

нее обстоятельство весьма важно, так как на

каком-то этапе работы с SPICE-симулятором

каждый пользователь сталкивается с необхо-

димостью пополнения библиотеки моделей.

К радости пользователей симулятора LTspice

можем сообщить, что проблема пополнения

встроенной библиотеки новыми моделями

уже в значительной степени решена поколе-

ниями энтузиастов, работающих с этой про-

граммой. Много дополнительных моделей

можно найти в файловом архиве независи-

мой пользовательской группы программы

LTspice/SwitcherCAD III [3]. Кроме того, следу-

ет посетить небольшую, но весьма информа-

тивную домашнюю страничку Андрея Кадат-

ча [4] и скачать дополнительную библиотеку

EXTRA, которая выводит объем библиотеки

LTspice на уровень, сравнимый с библиоте-

ками коммерческих симуляторов.

К сожалению, даже пополненная библиоте-

ка не гарантирует того, что в какой-то момент

под рукой окажется необходимая модель.

Во многих коммерческих SPICE-симуляторах

присутствуют специальные утилиты, позволя-

ющие рассчитывать параметры стандартных

моделей по справочным данным реальных ком-

понентов. Разумеется, в бесплатной программе

подобная утилита отсутствует, однако это не

мешает пользователям LTspice воспользовать-

ся результатами расчета сторонней программы.

Практически все производители электронных

компонентов выкладывают соответствующие

SPICE-модели этих компонентов на своих ин-

тернет-сайтах. Обычно эти модели выполнены

в виде подсхем. Остается только корректно по-

полнить этими моделями существующую биб-

лиотеку. Если используется стандартная модель,

то процесс пополнения простой и выполняет-

ся без особых проблем. Если же используется

модель в виде подсхемы, то пополнение услож-

няется и не всегда может закончиться успешно.

Рассмотрим оба этих варианта.

Пополнение библиотеки 
схемными элементами, 
имеющими стандартную модель

Параметры схемных элементов, имеющих

стандартные модели, расположены в подка-

талоге /lib/cmp относительно корневого ка-
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талога программы. Здесь можно обнаружить

следующие файлы:
•• standard.bjt — библиотека моделей бипо-

лярных транзисторов;
•• standard.cap — библиотека моделей кон-

денсаторов;
•• standard.dio — библиотека моделей дио-

дов;
•• standard.ind — библиотека моделей индук-

тивностей;
•• standard.jft — библиотека моделей поле-

вых транзисторов с управляющим p-n-пе-

реходом (JFET);
•• standard.mos — библиотека моделей поле-

вых транзисторов с изолированным затво-

ром (MOSFET).

Каждая строка в этих файлах, кроме stan-

dard.cap и standard.ind, представляет собой со-

ответствующую директиву .model. Следова-

тельно, пополнение этих библиотек можно

осуществить простым вписыванием очеред-

ной директивы .model с соответствующими

параметрами. Например, дополним библио-

теку биполярных транзисторов моделью оте-

чественного транзистора типа КТ315А:

.model kt315a NPN (Is=2.82f Xti=3 Eg=1.11 Vaf=3.32K Bf=55 Ne=2.35

Ise=554.1p Ikf=18.04m Xtb=1.5

+ Br=.6455 Nc=2 Isc=0 Ikr=0 Rc=0 Cjc=17p Vjc=.75 Mjc=.333 Fc=.5

Cje=8.55p Vje=.75 Mje=.333

+ Tr=3.36u Tf=1.02n Itf=0 Vtf=0 Xtf=0 Vceo=25 Icrating=100m

mfg=USSR)

Последние три параметра Vceo, Icrating,

mfg=USSR в моделировании не участвуют,

но, соответственно, позволяют вывести

в строке выбора транзистора его максималь-

ное напряжение коллектор-эмиттер, ток кол-

лектора и наименование производителя.

После дополнения библиотечного файла

транзистор KT315A становится доступным

для использования (рис. 1).

Пополнение библиотеки 
схемными элементами, имеющими
модель в виде подсхемы

Если модель существует в виде подсхемы,

то в этом случае придется решить, как мини-

мум, две задачи. Во-первых, надо создать но-

вый или подобрать готовый символ для бу-

дущего библиотечного элемента. Во-вторых,

надо согласовать SPICE-синтаксис, исполь-

зуемый при описании модели, с синтаксисом

LTspice.

Например, пополним библиотеку отечест-

венным операционным усилителем типа

К544УД2 (рис. 2).

Приведем текст подсхемы модели этого

операционного усилителя:

* k544ud2 operational amplifier “macromodel” subcircuit

* created using Parts version 1.04 on 10/11/90 at 10:58

*

* connections: non-inverting input

* | inverting input

* | | positive power supply

* | | | negative power supply

* | | | | output

* | | | | | compensation

* | | | | | / \

.subckt k544ud2 1 2 3 4 5 6 7

*

c1 11 12 174.6E-15

dc 5 53 dx

de 54 5 dx

dlp 90 91 dx

dln 92 90 dx

dp 4 3 dx

egnd 99 0 poly(2) (3,0) (4,0) 0 .5 .5

fb 7 99 poly(5) vb vc ve vlp vln 0 127.3E6 -100E6 100E6 100E6 -100E6

ga 6 0 11 12 1.885E-3

gcm 0 6 10 99 188.5E-9

iss 3 10 dc 400.0E-6

hlim 90 0 vlim 1K

j1 11 2 10 jx

j2 12 1 10 jx

r2 6 9 100.0E3

rd1 4 11 530.5

rd2 4 12 530.5

ro1 8 5 50

ro2 7 99 25

rp 3 4 9.000E3

rss 10 99 500.0E3

vb 9 0 dc 0

vc 3 53 dc 2

ve 54 4 dc 2

vlim 7 8 dc 0

vlp 91 0 dc 20

vln 0 92 dc 20

.model dx D(Is=800.0E-18)

.model jx PJF(Is=15.00E-12 Beta=17.77E-3 Vto=-1)

.ends

Синтаксис различных SPICE-симулято-

ров может иметь различия. Поэтому, если

подсхема модели заимствована у другого

симулятора или взята с сайта производите-

ля электронных компонентов, необходимо

внимательно просмотреть ее текст, чтобы

выявить и ликвидировать  синтаксические

несоответствия.

Сравнив нумерацию выводов реального

операционного усилителя (рис. 2) и порядок

узлов в строке директивы “.subckt k544ud2

1 2 3 4 5 6 7”, можно заметить их несоответ-

ствие. Соответствие нумерации и порядка уз-

лов подсхемы может потребоваться, если

схемный редактор LTspice используется как

генератор списка связей для сторонней про-

граммы, например, предназначенной для раз-

водки печатной платы. В данном случае такая

задача не ставится, и поэтому для нормаль-

ного функционирования модели достаточно

лишь обеспечить верный порядок передачи

узловых потенциалов из основной схемы

в подсхему, без привязки к физической реа-

лизации самой микросхемы.

Так как операционный усилитель являет-

ся стандартным электронным узлом, то най-

ти для него готовый символ скорей всего не

составит труда. И в самом деле, требуемый

символ можно позаимствовать у операцион-

ного усилителя LT1008, который расположен

в подкаталоге Opamps встроенной библиоте-

ки (рис. 3).

Чтобы использовать готовый символ, мы

должны знать порядок, в котором он переда-

ет узлы в подсхему модели. Этот порядок

можно узнать, воспользовавшись редакто-

ром символов программы LTspice, который

будет далее рассмотрен подробно, а пока по-

стараемся решить эту проблему при помо-

щи схемного редактора. Для этого, восполь-

зовавшись командой Edit=>Component или

нажав клавишу F2, загрузим символ требуе-

мого операционного усилителя из раздела

Opamps встроенной библиотеки и разместим

его в рабочем поле схемного редактора. Далее,

воспользовавшись командой Edit=>Draw

Wire или нажав клавишу F3, подключаем

к выводам операционного усилителя корот-

кие фрагменты внешних цепей и принуди-

тельно присваиваем им имена, соответству-

ющие порядку перечисления узлов в строке

директивы .subckt подсхемы модели опера-

ционного усилителя К544УД2 (рис. 4).

Чтобы присвоить имя цепи, нужно вызвать

соответствующее меню операций, щелкнув

по требуемой цепи правой кнопкой мышки.

В появившемся меню выбрать режим Label

Net («Ярлык для цепи»), что позволит полу-

чить доступ к меню Net Name («Имя цепи»),

где в строке ABC присваивается требуемое

имя (рис. 4).

Воспользовавшись командой View=>SPICE

Netlist, посмотрим список связей нашей не-

большой схемы (рис. 5) и убедимся, что по-

Рис. 1. Выбор биполярного транзистора КТ315А

из библиотеки LTspice

Рис. 2. Схема включения 

операционного усилителя К544УД2

Рис. 3. Поиск подходящего символа 

во встроенной библиотеке программы LTspice
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рядок узлов в строке “XU1 1 2 3 4 5 6 7 LT1008”

соответствует порядку узлов в строке “.sub-

ckt k544ud2 1 2 3 4 5 6 7”. В противном слу-

чае необходимо соответствующим образом

отредактировать строку директивы .subckt.

Программа LTspice регулярно обновляет-

ся через Интернет. Поэтому, чтобы не поте-

рять свои библиотеки, желательно выделить

их в свою пользовательскую папку. Чтобы

папка была видна при выборе нового компо-

нента, ее необходимо разместить в подката-

логе sym встроенной библиотеки. Присвоим

этот папке имя Mylib. Создадим в этой пап-

ке файл r-opamp.lib и скопируем туда выше-

указанный текст подсхемы модели. Впослед-

ствии этот файл можно пополнять другими

моделями операционных усилителей отече-

ственного производства. В начале файла, в ви-

де комментариев, необходимо сделать неболь-

шую информационную вставку, описываю-

щую содержимое библиотеки. Это облегчит

работу с библиотекой, а также позволит из-

бежать каких-то досадных ошибок.

Пример информационной вставки:

*******************************************************************

* Библиотека моделей операционных усилителей 

* отечественного производства

*

*******************************************************************

*

* Библиотека сoдержит: 

* К544УД2

*

*******************************************************************

* Внимание! Нумерация (порядок) входных узлов подсхем 

* моделей всех ОУ не совпадает с реальной нумерацией выводов 

* корпуса микросхем.

*******************************************************************

Примечание. Для схемных элементов раз-

личных типов лучше создавать независимые

библиотечные файлы. Например, для ШИМ-

контроллеров можно создать файл pwm.lib,

для полевых транзисторов с изолированным

затвором — mosfet.lib и т. д.

Скопируем файл символа LT1008.asy из

своего каталога ..\lib\sym\Opamps в пользо-

вательский каталог ..\lib\sym\ Mylib и пере-

именуем его в k544ud2.asy. Однако одного пе-

реименования недостаточно. Необходимо

также внести некоторые изменения и в сам

файл. Для этого откроем его при помощи лю-

бого текстового редактора и изменим содер-

жимое атрибутов SYMATR:

SYMATTR Value — вместо LT1008 записываем k544ud2

SYMATTR Prefix X — оставляем без изменения

SYMATTR SpiceModel — вместо LTC.lib записываем r-opamp.lib

SYMATTR Value2 — вместо LT1008 записываем k544ud2

SYMATTR Description — запишем Operational Amplifier

После этого сохраним изменения и при-

ступим к испытанию. Для этого запустим

программу LTspice в режиме схемного редак-

тора и проверим наличие нового электрон-

ного компонента в библиотеке. Если все сде-

лано правильно, то операционный усилитель

К544УД2 можно обнаружить именно там, где

он и должен быть, то есть в пользовательском

каталоге Mylib (рис. 6).

Для проверки функционирования схемно-

го элемента можно собрать какую-то тесто-

вую схему. Пусть такой схемой будет обыч-

ный инвертирующий усилитель (рис. 7).

Согласно результатам моделирования, мо-

дель операционного усилителя К544УД2

функциональна, и инвертирующий усили-

тель, собранный на нем, обеспечивает задан-

ное усиление Kу = R3/R2 = 100к/10к =10. 

Рис. 4. Присвоение имен внешним цепям символа операционного усилителя LT1008 Рис. 5. Проверка порядка узлов, передаваемого символом LT1008 в подсхему модели

Рис. 6. Выбор операционного усилителя К544УД2

из библиотеки пользователя

Рис. 7. Тестовая схема инвертирующего усилителя на ОУ К544УД2
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Создание модели схемного 
элемента с использованием 
иерархической схемы

Ранее мы рассмотрели случаи создания

схемного элемента, когда его модель уже су-

ществует в том или ином виде. Обычно так

и происходит, но иногда бывают ситуации,

когда модели нет, и ее невозможно найти ни

в одном из доступных информационных ис-

точников. В этом случае приходится созда-

вать схемный элемент с нуля. Обычно созда-

ние нового элемента начинается с создания

его модели.

В качестве примера, используя средства

программы LTspice, создадим модель микро-

схемы TL494. Микросхема TL494 является

ШИМ-контроллером импульсного источни-

ка питания и включает в себя все необходи-

мые для этого блоки. Эта микросхема, благо-

даря своим достаточно высоким характерис-

тикам и низкой стоимости, очень популярна

как среди любителей, так и среди профессио-

налов в силовой электронике. Так же как

и широко известный 555-й таймер, TL494 вы-

пускают многие мировые производители эле-

ктронных компонентов, такие как Texas

Instruments, ON Semiconductor, Motorola,

Fairchild Semiconductor, Fujitsu, Samsung и т. д.

Эта микросхема выпускается под своим ори-

гинальным, а также под альтернативными

названиями, такими как mPC494C, MB3759,

KA7500B, IR3M02 и т. п. Отечественной вер-

сией TL494 является микросхема 1114ЕУ4.

Однако, несмотря на популярность, модель

TL494 пока отсутствует в библиотеках ком-

мерческих симуляторов и на сайтах произво-

дителей электронных компонентов.

Иерархические схемы

В программе LTspice предусмотрена очень

полезная возможность замены отдельных

фрагментов схемы схемами с более низким

уровнем иерархии. Причем, в основной схеме,

имеющей высокий уровень, эти иерархичес-

кие схемы выглядят как абстрактные символы

с выводами. В этом смысле иерархические схе-

мы, по сути, очень похожи на подсхемы, но го-

раздо удобнее и нагляднее, так как пользова-

телю приходится работать не с текстовым фай-

лом, а с реальной схемой. Ее легко изменить

и контролировать обычными средствами схем-

ного редактора программы LTspice.

Так же как и подсхемы, иерархические схе-

мы могут быть помещены в библиотеку для

последующего использования в различных

проектах. Но, в отличие от подсхем, ссылать-

ся на иерархическую схему из основного про-

екта можно только с помощью символа. Файл

символа должен иметь такое же имя, что

и файл иерархической схемы. Например, ес-

ли файл иерархической схемы имеет название

tl494h.asc, то файл символа должен иметь на-

звание tl494h.asy. По этой же причине имя

символа не должно содержать пробелы, а так-

же символы, недопустимые для имени файла.

Примечание. Иерархическая схема должна

располагаться в одном каталоге с основной

схемой.

Имена выводов символов должны соответ-

ствовать именам соответствующих цепей ие-

рархической схемы. Таким образом, создает-

ся связь между основной и иерархическими

схемами.

Любой файл, открытый с помощью коман-

ды File=>Open, рассматривается как схема

высокого уровня.

Создание модели TL494 

в виде иерархической схемы

Справочную информацию о микросхеме

TL494 можно взять, например, на сайте компа-

ний Texas Instruments [5] или ON Semiconductor

[6].

На рис. 8 изображена ее функциональная

схема. 

Казалось бы, что для создания корректной

модели достаточно найти и продублировать

принципиальную электрическую схему

TL494. Благо, упрощенные версии отдельных

узлов даже приводятся в документации, рас-

положенной на сайте Texas Instruments [7].

Однако попытка создания модели таким

способом скорей всего закончится неудачей.

Дело в том, что, несмотря на свои маленькие

размеры, микросхема имеет достаточно слож-

ную электрическую принципиальную схему,

содержащую более 50 транзисторов. Модель,

содержащая такое количество активных эле-

ментов, способна в значительной мере сни-

зить скорость симуляции или сделать ее вооб-

ще невозможной из-за проблем сходимости.

Выход из данной ситуации — использование

встроенных схемных элементов LTspice, кото-

рые являются функциональными аналогами

отдельных узлов моделируемой микросхемы.

Генератор

ШИМ-контроллер TL494 работает на фик-

сированной частоте, которая определяется

внутренним генератором. Частота генерато-

ра программируется внешними резистором

и конденсатором, подключаемыми к выводам

Rт и Cт микросхемы. Конденсатор Cт заря-

жается стабильным током, величина которо-

го задается с помощью резистора Rт. После

того, как напряжение на конденсаторе дости-

гает 3 В, он быстро разряжается до нуля,

и процесс снова повторяется. Величину за-

рядного тока можно определить по форму-

ле Iзар ≈ 3,65/Rт. На рис. 9 приведены графи-

ческие зависимости частоты внутреннего ге-

нератора от номиналов частотозадающих

элементов. Эту частоту также можно опреде-

лить по формуле Fген = 1,2/(RT·CT).

Схема модели генератора изображена на

рис. 10.

Источник напряжения V1 имитирует напря-

жение, приложенное к резистору Rт. ИТУТ (ис-

точника тока, управляемый током) F1 являет-

ся своеобразным токовым зеркалом, которое

формирует ток зарядки конденсатора Cт, рав-

ный току, протекающему через источник на-

пряжения V1 и резистор Rт. Под воздействи-

Рис. 8. Функциональная схема TL494

Рис. 9. Частота генератора и ее температурный дрейф

в зависимости от величин Rт и Cт
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ем этого тока конденсатор Cт линейно заряжа-

ется. Как только напряжение на конденсаторе

достигает порогового напряжения 3 В, он раз-

ряжается с помощью ключа S1. Диод D1 пре-

дотвращает обратный ток и позволяет напря-

жению на выводе Rт подниматься выше по-

тенциала источника напряжения V1.

При указанных на схеме номиналах резис-

тора Rт = 12 кОм и конденсатора Cт = 10 мкФ

рабочая частота генератора составляет 10 кГц,

что соответствует графической зависимости

на рис. 9.

Усилитель ошибки

Регулировочные характеристики ШИМ-

контроллера определяются амплитудно-ча-

стотной характеристикой (АЧХ) его усили-

теля ошибки. Поэтому при создании модели

усилителя нужно обеспечить корректность

этой характеристики. Согласно документа-

ции Texas Instruments и других производите-

лей, АЧХ усилителя ошибки имеет частоту

среза 10 Гц с последующим завалом 20 дБ/дек

(рис. 11).

Подобную АЧХ можно легко получить

с помощью RC-фильтра нижних частот. Схе-

ма модели усилителя ошибки с RC-фильт-

ром нижних частот, а также результаты мо-

делирования изображены на рис. 12.

Фильтр нижних частот R1, C1 позволяет

получить АЧХ, которая идеально совпадает

с изображенной на рис. 11.

Нелинейность передаточной характеристи-

ки усилителя ошибки, а также коэффициент

усиления на низких частотах имитируются

с помощью ИНУН (источник напряжения, уп-

равляемый напряжением) E1. Согласно общим

справочным данным на ШИМ-контроллер

TL494 (документация t1494.pdf и TL494-D.PDF),

коэффициент передачи усилителя ошибки

AVOL = 50 000 (95 дБ). Коэффициент усиле-

ния и передаточную характеристику усили-

теля ошибки представим в виде таблицы

“table=(0,0 1.96m,0 2m,2 2.04m,4 20m,4.5)”.

Источник напряжения V2 определяет ра-

бочую точку усилителя ошибки, а резистор

R3 играет роль его нагрузки во время AC-ана-

лиза.

Выходной каскад

Выходной каскад контроллера TL494 пред-

ставляют собой транзистор с открытыми

эмиттером и коллектором. Благодаря этому,

возможны два варианта включения этого

транзистора, где он включен по схеме с об-

щим эмиттером (рис. 13а) или общим кол-

лектором (рис. 13б). Каждому из этих вклю-

чений соответствует своя зависимость напря-

жения открытого транзистора Vкэ.нас от тока

нагрузки.

Желательно, чтобы модель корректно ими-

тировала эти характеристики насыщения,

а также ситуации превышения максимально-

го тока и пробоя повышенным напряжени-

ем транзистора выходного каскада.

Сначала рассмотрим модель выходного ка-

скада, включенного по схеме с общим эмит-

тером, изображенную на рис. 14.

С помощью ИТУН G1 и стабилитрона D1

имитируется открытый транзистор выход-

ного каскада. Этот эквивалентный транзис-

тор полностью открыт, если ток нагрузки I1

не превышает максимально допустимого

значения в 250 мА (для микросхемы TL494

производства Texas Instruments). При превы-

шении максимального тока эквивалентный

транзистор насыщается, и напряжение на его

Рис. 10. Схема модели задающего генератора

Рис. 11. Амплитудно�частотная характеристика

усилителя ошибки

Рис. 12. Модель усилителя ошибки

Рис. 13. Характеристики напряжения насыщения транзистора выходной схемы для включения: 

а) с общим эмиттером; б) с общим коллектором

а б
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выводах резко возрастает (участок 3 ВАХ).

В области малых токов (участок 1) ВАХ эк-

вивалентного транзистора определяется

внутренним сопротивлением Ron диода D3,

а в области средних токов (участок 2) —

внутренним сопротивлением параллельно

включенных диодов D2 и D3. Пробой экви-

валентного транзистора при повышенном

напряжении имитируется стабилитроном

D1, имеющим напряжение стабилизации

Vrev = 41 В. ИТУН G2 в данном режиме не

активен, так как напряжение управления

всегда равно напряжению питания микро-

схемы. 

Теперь рассмотрим модель выходного ка-

скада, включенного по схеме с общим кол-

лектором, изображенную на рис. 15.

В схеме с общим коллектором ИТУН G2

контролирует напряжение на открытом

транзисторе выходного каскада. Коэффи-

циент передачи G2 описывается таблицей

“table=(0 250m,1.42 243m,1.46 150m,1.57 0)”.

Согласно этой таблице, если входное напря-

жение ИТУН G2 падает ниже 1,57 В, послед-

ний начинает шунтировать выход ИТУН G1.

Следствием этого шунтирования будет сдвиг

ВАХ открытого транзистора в сторону боль-

ших напряжений.

Потребляемый ток 

и источник опорного напряжения

Ток Icc, потребляемый микросхемой TL494,

имеет нелинейную зависимость от питающе-

го напряжения Vcc. Эта зависимость изобра-

жена на рис. 16.

На рис. 17 изображена модель, которая

с помощью ИТУН G1 имитирует потребля-

емый ток микросхемы. Коэффициент пере-

дачи ИТУН задан таблицей “table=(1 0,5 4.5m,

6.85 7.6m,40 8.4m)”. Источник опорного на-

пряжения имитируется при помощи источ-

ника тока I1 и стабилитрона D1. Ток нагруз-

ки источника опорного напряжения, при по-

мощи поведенческого источника тока B1,

суммируется к току, потребляемому микро-

схемой. В соответствии со справочными дан-

ными, ток короткого замыкания источника

опорного напряжения составляет 25 мА.

Общая схема модели микросхемы TL494

После того, как созданы основные узлы мо-

дели, создание общей схемы модели (рис. 18)

не вызывает особых затруднений.

Всем внешним цепям иерархической схе-

мы необходимо присвоить имена. Удобнее

всего использовать имена соответствующих

выводов микросхемы прототипа. Чтобы при-

своить имя цепи, нужно вызвать соответст-

вующее меню операций, щелкнув по требу-

емой цепи правой кнопкой мышки. В по-

явившемся меню выбрать режим Label Net

(«Ярлык для цепи»), что позволит получить

доступ к меню Net Name («Имя цепи»), где

в строке ABC указывается требуемое имя

(рис. 19). Для большей наглядности можно

определить направления сигнала во внешних

цепях с помощью указателя Port type:
•• None — без направления;
•• Input — входная цепь;
•• Output — выходная цепь;
•• Bi-Direct — двунаправленная цепь.

Указатель Port type на процессы моделиро-

вания не влияет.

Общий провод внутри иерархической схе-

мы лучше не подключать к «земле», а соеди-

нить явно или подключить к цепи “COM”.

Это позволит в дальнейшем использовать

модель в схемах с плавающим, относитель-

но «земли», питанием. 

При помощи команды File=>Save As… на-

зовем как TL494H.asc и сохраним в пользо-

вательский каталог ..\lib\sym\ Mylib получен-

ную иерархическую схему модели TL494.

Редактор символов

Каждый схемный элемент имеет собствен-

ный символ, позволяющий легко идентифи-

цировать его на электрической принципиаль-

ной схеме. Внешний вид символов схемных

элементов, таких как резисторы, конденсато-

ры, индуктивности, диоды, транзисторы и т. п.,

оговаривается соответствующим стандартом

на конструкторскую документацию. В насто-

ящее время в мире существует два основных

стандарта, один из которых американский,

а другой — европейский. К последнему весь-

ма близка отечественная «Единая система кон-

структорской документации» (ЕСКД). В биб-

лиотеках LTspice использован американский

стандарт на символы схемных элементов.

С этим можно смириться, так как обычно дан-

ный симулятор не используется для подготов-

ки конструкторской документации, но при не-

обходимости символы схемных элементов

можно привести к более привычному виду.

Окно редактора символов

В LTspice имеется специальный редактор

символов, с помощью которого можно изме-

нять существующие или создавать новые

символы схемных элементов. Для запуска

этого редактора необходимо активизировать

команду File=>New Symbol. В результате по-

явится окно редактора символов (рис. 20).

Рис. 14. Модель выходного каскада, 

включенного по схеме с общим эмиттером

Рис. 15. Модель выходного каскада, 

включенного по схеме с общим коллектором

Рис. 16. Зависимость тока, 

потребляемого микросхемой TL494, 

от питающего напряжения

Рис. 17. Модель источника опорного напряжения

и имитатора потребляемого тока
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Отличительный признак этого окна —

крестик с кружком в центре рабочего поля,

а также синий символ логического вентиля

в левой части панели команд. 

Панель команд редактора символов

Панель меню команд очень похожа на ана-

логичную панель схемного редактора. В от-

личие от панели команд схемного редактора

здесь присутствует меню Draw, но зато отсут-

ствует меню Simulate. 

Рассмотрим подробнее подпункты меню

команд:
•• File — подпункты этого меню аналогичны

подпунктам меню File схемного редактора.
•• Edit — служит для редактирования симво-

ла и содержит следующие подпункты:

– Undo (F9) — отменить предыдущее дей-

ствие.

– Redo (Shift+F9) — вернуть отмененное

действие.

– Attributes — атрибуты символа: 

· Edit Attributes (Ctrl+A) — редактиро-

вать отдельные атрибуты символа;

· Attribute Window (Ctrl+W) — делать ви-

димыми отдельные атрибуты символа.

– Add Pin/Port ('P') — добавить электри-

ческое подключение (вывод) символу.

– Move (F7) — переместить выбранные

элементы символа. При этом существу-

ющие связи разрываются.

– Drag (F8) — перетащить выбранные эле-

менты символа. При этом существую-

щие связи сохраняются.

– Rotate (Ctrl+R) — вращать выбранные

элементы символа.

– Mirror (Ctrl+E) — отразить выбранные

элементы символа.

– Delete (F5) — удалить выбранные эле-

менты символа.

– Duplicate (F6) — копировать (дублиро-

вать) выбранные элементы символа.
•• Hierarchy — посмотреть внутреннюю

структуру иерархического символа.
•• Draw — создавать изображения символа при

помощи графических примитивов и текста:

– Line ('L') — выбрать рисование прямой

линии;

– Rect ('R') — выбрать рисование прямо-

угольника;

– Circle ('C') — выбрать рисование круга;

Рис. 19. Указание наименования и направления цепей Рис. 20. Окно редактора символов

Рис. 18. Иерархическая схема модели микросхемы TL494
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– Arc ('A') — выбрать рисование дуги;

– Line Style — определить стиль линии;

– Text ('T') — выбрать ввод текста.
•• View — управление режимом просмотра

изображения символа:

– Zoom In (Ctrl+Z) — увеличить изобра-

жение символа;

– Zoom to Fit — установить масштаб изо-

бражения, позволяющий максимально

использовать текущий размер рабочей

области редактора символов;

– Zoom Out (Ctrl+B) — уменьшить изоб-

ражение символа; 

– Anchor Points ('O') — включить/выклю-

чить видимость точек привязки графи-

ческих элементов или текста;

– Pin Table — вывести таблицу, связыва-

ющую имена выводов символа с их по-

рядковыми номерами;

– Status Bar — вывести/убрать строку под-

сказки редактора символа;

– Toolbar — вывести/убрать панель инст-

рументов редактора символа;

– Windows Tabs — вывести/убрать панель

вложенных окон.
•• Tools — подпункты этого меню аналогич-

ны подпунктам меню Tools схемного ре-

дактора.
•• Widows — подпункты этого меню анало-

гичны подпунктам меню Windows схемно-

го редактора.
•• Help — подпункты этого меню аналогичны

подпунктам меню Help схемного редактора.

Панель инструментов 

редактора символов

Панель инструментов редактора символов

полностью аналогична панели инструментов

редактора схем.

Создание изображения символа

В редакторе символов для создания изоб-

ражения символа используются различные

графические примитивы, такие как линия,

прямоугольник, круг и дуга. Кроме этого,

в изображение символа можно вносить текст,

который используется для наименования вы-

водов, а также для указания различных атри-

бутов символа.

Все графические и текстовые элементы сим-

вола имеют специальные точки привязки, ко-

торые отображаются в виде маленьких крас-

ных кружков, если, с помощью команды

View=>Mark Object Anchors, разрешена види-

мость точек привязки. Именно за эти точки

элементы перемещаются или перетаскивают-

ся при помощи команд Move (переместить)

и Drag (перетащить). Для улучшения ориен-

тации в рабочем поле редактора символов на-

несена сетка. Шаг сетки равен 16 внутренним

единицам программы, которые не имеют оп-

ределенной привязки к метрическим или дюй-

мовым мерам длины. Например, если судить

по резисторам, то этот шаг составляет при-

мерно 2,5 мм, а если по микросхемам, то при-

мерно 1,25 мм. Особо не вникая в эту пробле-

му, будем создавать новые символы, ориен-

тируясь на те подходы, которые уже исполь-

зуются в программе LTspice.

В качестве примера создадим символ

ШИМ-контроллера TL494 (рис. 21), для ко-

торого ранее уже была создана модель в ви-

де иерархической схемы.

Согласно неписанному соглашению, при-

нятому для символов микросхем из библио-

теки программы LTspice, расстояние между

отдельными выводами символа составляет

4 шага сетки. Поэтому, выбрав команду

Draw=>Rect, нарисуем прямоугольник ши-

риной 16 и высотой 32 клетки. Так как кур-

сор не привязан к узлам сетки, при этом при-

дется хорошенько прицеливаться. Результат

данных действий изображен на рис. 22.

Добавление выводов

Далее надо указать точки, в которых сим-

вол будет подключаться к схеме. Эти точки со-

здаются при помощи команды Edit=>Add

Pin/Port. Результатом будет появление окна

Pin/Port Properties (рис. 23). В области Pin Label

Position определяется видимость (NONE)

и расположение названия вывода. Вывод мо-

жет быть расположен левее (LEFT), правее

(RIGHT), выше (TOP) или ниже (BOTTOM)

своего названия. С помощью поля настройки

Offset можно определить смещение названия

относительно вывода во внутренних едини-

цах программы. По умолчанию это смещение

составляет 8 единиц, но может быть установ-

лено любое значение в диапазоне от 0 до 50.

Если символ представляет элемент, являю-

щийся нижним уровнем иерархической схе-

мы, то название вывода должно соответство-

вать названию цепи в схеме нижнего иерар-

хического уровня. Если символ представляет

стандартный SPICE-примитив, то название

вывода не имеет особого значения, но поряд-

ковый номер в поле Netlist Order должен со-

ответствовать номеру вывода соответствую-

щего схемного элемента. Это же справедливо

и для символа, представляющего библиотеч-

ный элемент в виде подсхемы. Но в этом слу-

чае номер в поле Netlist Order должен соответ-

ствовать порядковому номеру соответствую-

щего узла в строке директивы .SUBCKT.

Рис. 21. Схемотехническое обозначение 

ШИМ�контроллера TL494

Рис. 22. Заготовка символа ШИМ�контроллера TL494

Рис. 23. Окно Pin/Port Properties, 

определяющее свойства вывода

Рис. 24. Вид символа микросхемы TL494 

после добавления всех выводов
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Если создаваемый с нуля схемный элемент

не является стандартным SPICE-примитивом,

то желательно, чтобы нумерация выводов его

символа соответствовала нумерации выво-

дов оригинального электронного элемента,

которую указывает производитель в виде

справочных данных.

Ошибки, допущенные при добавлении вы-

водов, можно легко исправить, если повтор-

но вызвать окно Pin/Port Properties, щелкнув

правой кнопкой мышки по соответствующе-

му выводу символа.

На рис. 24 изображен результат, который

должен быть получен после добавления всех

выводов символа микросхемы TL494.

Добавление атрибутов

Чтобы получить доступ к атрибутам сим-

вола, необходимо с помощью команды

Edit=>Attributes=>Edit Attributes вызвать ок-

но редактирования атрибутов Symbol

Attribute Editor (рис. 25). В строке Symbol Type

необходимо выбрать тип символа:
•• Cell — тип соответствует символам элемен-

тов, имеющих встроенную SPICE-модель

или модель в виде подсхемы. Для этих сим-

волов надо указывать атрибут Prefix. 
•• Block — тип соответствует символам эле-

ментов, имеющих модель в виде иерархи-

ческой схемы. Для этих символов не надо

указывать атрибут Prefix. 

Далее, в виде таблички, перечисляются все

атрибуты символа:
•• Prefix — этот атрибут является наиболее

важным. Он определяет тип схемного эле-

мента. Например, резистор имеет пре-

фикс R, конденсатор — C, MOSFET-тран-

зистор — M и т. д. Если модель схемного

элемента представлена подсхемой, то ис-

пользуется префикс X. Возможна ситуа-

ция, когда модель стандартного схемного

элемента, например, MOSFET-транзисто-

ра, представлена подсхемой. В этом случае

символу схемного элемента также присва-

ивается префикс X.
•• SpiceModel — полное или относительное

имя библиотечного файла, включающего

модель схемного элемента.
•• Value — атрибут отображается на схеме

и обозначает номинал или тип схемного

элемента.
•• Value2 — атрибут выводится в список со-

единений и должен совпадать с именем

подсхемы в библиотечном файле. Если

этот атрибут указан, редактирование эле-

мента на схеме становится недоступным.
•• SpiceLine — атрибут позволяет передавать

параметры в подсхему.
•• SpiceLine2 — атрибут позволяет передавать

параметры в подсхему.
•• Description — атрибут, позволяющий вста-

вить краткое описание схемного элемента.
•• ModelFile — атрибут позволяет определить

файл, который будет включен в список со-

единений как библиотечный. Использова-

ние этого атрибута меняет назначение ат-

рибута SpiceModel, который теперь указы-

вает название конкретной подсхемы

в библиотечном файле. В свою очередь,

в окне редактирования компонента появ-

ляется строка выбора, позволяющая выби-

рать отдельные подсхемы библиотечного

файла. Хорошим примером использова-

ния этого атрибута является пара символа

“..lib/sym/Opamps/UniversalOpamp2.asy”

и подсхемы “..lib/sub/UniversalOpamps2.sub”

(рис. 26).

Атрибуты SpiceModel, Value, Value2, SpiceLine

и SpiceLine2 формируют строку текстового опи-

сания компонента в формате SPICE списка со-

единений. В результате генерируется SPICE-

строка, которая выглядит следующим образом:

<Имя> узел1 узел2 [...] <SpiceModel> <Value> <Value2>

<SpiceLine> <SpiceLine2>

Компонент, имеющий префикс X и опре-

деленные атрибуты Value и Value2, в списке

связей представлен двумя SPICE-строками:

<name> node1 node2 [...] <Value2>

.lib <SpiceModel> 

Как говорилось ранее, редактирование та-

кого компонента недоступно из редактора

схем. 

Также двумя SPICE-строками в списке со-

единений представлен компонент, имею-

щий префикс X и определенный атрибут

ModelFile:

<name> node1 node2 [...] <SpiceModel> <Value> <Value2> <SpiceLine>

<SpiceLine2>

.lib <ModelFile> 

Редактирование такого компонента доступ-

но из редактора схем.

На рис. 27 показано окно редактирования

атрибутов Symbol Attribute Editor, заполнен-

ное для символа схемного элемента TL494,

модель которого выполнена в виде иерархи-

ческой схемы.

Рис. 25. Окно редактирования атрибутов символа

Рис. 26. Пример использования атрибута ModelFile

Рис. 27. Окно редактирования атрибутов, 

заполненное для символа TL494
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Видимость атрибутов

Пользователь может сам выбирать те ат-

рибуты, которые должны быть видимыми на

изображении символа. Видимость атрибутов

устанавливается при помощи окна Attribute

Windows to Add, которое вызывается командой

Edit=>Attributes=>Attribute Window (рис. 28).

Выбрав требуемый атрибут из списка, не-

обходимо нажать кнопку OK. После этого ат-

рибут можно разместить в рабочем поле ре-

дактора символов. После размещения атри-

бута можно редактировать его текст, изменять

выравнивание и направление написания. Все

это позволяет меню Symbol Attribute (рис. 29),

которое вызывается щелчком правой кнопки

мышки по тексту атрибута.

На рис. 30 показан внешний вид символа

микросхемы TL494 после добавления атри-

бутов.

При помощи команды File=>Save As… на-

зовем как TL494H.asy и сохраним в пользо-

вательский каталог ..\lib\sym\ Mylib получен-

ный символ.

Проверка схемного элемента, 
созданного в виде 
иерархической схемы

После того как созданы и размещены

в пользовательском каталоге символ и мо-

дель схемного элемента, можно приступить

к его проверке. Для проверки можно исполь-

зовать тестовую схему из документации про-

изводителя (рис. 31).

Для этого запустим программу LTspice/

SwitcherCAD III в режиме схемного редакто-

ра и проверим наличие нового электронно-

го компонента в библиотеке. Если все сдела-

но правильно, то ШИМ-контроллер TL494H

можно обнаружить именно там, где он и дол-

жен быть, то есть в пользовательском ката-

логе Mylib (рис. 32).

Разместив символ в рабочем поле схемно-

го редактора, щелкнем по нему, чтобы вы-

звать окно настройки Navigate/Edit Schematic

Block. В верхней части окна расположены две

кнопки — Open Symbol и Open Schematic, ко-

торые позволяют получить доступ к симво-

лу или схеме иерархического схемного бло-

ка. Ниже, в поле Instance Name необходимо

указать позиционное обозначение схемного

элемента. По умолчанию там, как для под-

схемы, написано X1. Далее, в поле PARAMS

можно перечислить параметры, которые не-

обходимо передать в иерархическую схему.

Окна выбора Visible позволяют включать

и выключать видимость информации, вве-

денной в соответствующем поле.

Иерархическому схемному элементу, в от-

личие от встроенных, можно присваивать по-

зиционное обозначение с любым префиксом.

Поэтому впишем в поле Instance Name более

Рис. 28. Окно видимости атрибутов символа

Рис. 29. Меню редактирования текста атрибута

Рис. 30. Вид символа микросхемы TL494 

после добавления атрибутов

Рис. 31. Схема проверки ШИМ�контроллера TL494, рекомендуемая производителем

Рис. 32. Выбор ШИМ�контроллера TL494H

из библиотеки пользователя

Рис. 33. Окно настройки иерархического

схемного блока
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привычное наименование — DA1 и нажмем

кнопку OK (рис. 33).

Далее, в уже знакомой манере, создадим

схему тестирования микросхемы TL494 и за-

пустим процесс моделирования (рис. 34).

Создание модели 
схемного элемента 
с использованием подсхемы

Несмотря на многие положительные каче-

ства, такие как наглядность и удобство редак-

тирования, иерархические схемы имеют и не-

которые недостатки. Например, невозможно

использовать модели в виде иерархической

схемы на других SPICE-симуляторах, а так-

же следует держать файл иерархической схе-

мы в одном каталоге с основной схемой.

Преобразование иерархической схемы

в библиотечную подсхему

Рассмотрим процесс преобразования ие-

рархической схемы в соответствующую ей

подсхему. Подобное преобразование можно

произвести с помощью схемного редактора

программы LTspice. Для этого загрузим в его

окно иерархическую схему контроллера

TL494H (рис. 18), созданную на предыдущих

этапах. Далее можно сгенерировать список

связей, но перед этим стоит сбросить флажок

напротив опции Default Devices, расположен-

ной на вкладке Netlist Options окна Control

Panel, которое вызывается командой Tools=>

Control Panel. Это позволит исключить не-

нужные строки определения моделей по

умолчанию. После этого, при помощи ко-

манды View=>SPICE Netlist, вызовем окно

просмотра списка связей иерархической схе-

мы (рис. 35).

Теперь необходимо выделить весь текст

списка связей, с помощью комбинации кла-

виш Ctrl-C скопировать его в буфер обмена,

а затем вставить в окно любого текстового

редактора, например в блокнот. Чтобы пре-

вратить полученный список связей в подсхе-

му, необходимо вставить в него соответству-

ющие директивы. В начале списка вставляет-

ся строка:

.subckt tl494 IN1 -IN1 IN2 -IN2 FB DTC Vref OCT CT1 ET1 CT2 ET2

Ct Rt GND Vcc

Порядок перечисления узлов должен соот-

ветствовать порядку, в котором эти узлы пе-

редаются в подсхему. Напомним, что он ус-

танавливается для каждого вывода символа

в поле Netlist Order (рис. 23) при его описа-

нии.

В конце списка удаляются строки с дирек-

тивами .backanno и .end, а вместо них встав-

ляется директива конца подсхемы .ENDS.

В результате должен получиться следую-

щий список соединений:

* 

.subckt tl494 IN1 -IN1 IN2 -IN2 FB DTC Vref OCT CT1 ET1 CT2 ET2

Ct Rt GND Vcc

A1 N005 0 N006 0 0 N005 N011 0 DFLOP Vhigh=5 Trise=50n Rout=30

A2 0 0 0 N009 N011 0 N007 0 AND Vhigh=5 Trise=50n Rout=30

A3 N005 N009 0 0 0 0 N013 0 AND Vhigh=5 Trise=50n Rout=30

A4 N006 N007 0 0 0 N004 0 0 OR Vhigh=5 Trise=300n Rout=30

A5 N006 N013 0 0 0 N015 0 0 OR Vhigh=5 Trise=300n Rout=30

G1 N002 ET1 N004 0 table=(1 0,4 250m)

G3 N014 ET2 N015 0 table=(1 0,4 250m)

A6 N008 N012 0 0 0 0 N006 0 OR Vhigh=5 Trise=50n Rout=30

A7 N010 Ct 0 0 0 0 N008 0 SCHMITT Vt=0 Vh=0 Vhigh=5

A8 FB N016 0 0 0 0 N012 0 SCHMITT Vt=0 Vh=0 Vhigh=5

V4 N016 Ct 0.7

V5 N010 DTC 0.1

D5 N018 FB IDEAL

D6 N020 FB IDEAL

R1 IN1 N017 1meg

R3 IN2 N019 1meg

C4 N017 -IN1 15.9n

C5 N019 -IN2 15.9n

D1 ET1 N002 IDEALZ

E1 N018 0 N017 -IN1 table=(0,0 1.96m,0 2m,2 2.04m,4 20m,4.5)

E2 N020 0 N019 -IN2 table=(0,0 1.96m,0 2m,2 2.04m,4 20m,4.5)

R5 -IN1 0 5meg

R6 IN1 0 5meg

R7 -IN2 0 5meg

R8 IN2 0 5meg

I1 FB 0 0.7m

V2 N001 0 3.65

F1 0 Ct V2 -1

S1 0 Ct N003 0 OSC

D3 CT1 N002 IDEAL1

D7 CT1 N002 IDEAL2

G2 ET1 N002 Vcc ET1 table=(0 250m,1.42 243m,1.46 150m,1.57 0)

D2 ET2 N014 IDEALZ

D4 CT2 N014 IDEAL1

D8 CT2 N014 IDEAL2

G4 ET2 N014 Vcc ET2 table=(0 250m,1.42 243m,1.46 150m,1.57 0)

C7 N002 ET1 5p

C8 N014 ET2 5p

D9 N001 Rt IDEAL

R14 Ct 0 5meg

R15 ET2 0 5meg

R16 ET1 0 5meg

G5 Vcc 0 Vcc 0 TABLE=(1 0,5 4.5m,6.85 7.6m,40 8.4m)

I2 0 Vref 25m

D10 0 Vref IDEAL5

B1 Vcc 0 I=I(D10)+25m

R9 N009 OCT 1k

R10 Ct N003 5k

C1 N003 0 10p

.MODEL IDEALZ D(Ron=0 Roff=20meg Vfwd=0 Vrev=41)

.MODEL IDEAL D(Ron=0 Roff=1G Vfwd=0)

.model OSC SW(Ron=10 Vt=1.51 Vh=1.49 Ilimit=20m)

.MODEL IDEAL1 D(Ron=2 Roff=1G Vfwd=0.66)

.MODEL IDEAL2 D(Ron=175 Roff=1G Vfwd=0)

.MODEL IDEAL5 D(Ron=0 Roff=1G Vfwd=0 Vrev=5)

.ends tl494

Сохраним подсхему в пользовательскую ди-

ректорию ..lib\sym\Mylib под именем tl494.lib.

Редактирование символа 

схемного элемента

Загрузим в редактор символов созданный

ранее символ TL494H.asy и с помощью коман-

ды Edit=>Attributes=>Edit Attributes или ком-

бинации клавиш Ctrl-A вызовем окно редак-

тирования атрибутов символа. Далее отредак-

тируем его так, как это показано на рис. 36.

После этого сохраним символ в пользова-

тельскую директорию ..lib\sym\Mylib под име-

нем tl494.asy.

Проверка схемного элемента, 

созданного в виде подсхемы

Для проверки схемного элемента, создан-

ного в виде подсхемы, можно использовать

тестовую схему (рис. 34), которая ранее уже

использовалась для проверки схемного эле-

мента, созданного в виде иерархической схе-

мы. Для этого достаточно заменить схемный

элемент TL494H на вновь созданный TL494.

Так как схемный элемент создан в виде под-

Рис. 34. Тестовая проверка модели микросхемы TL494,

созданной в виде иерархической схемы

Рис. 35. Вызов списка связей иерархической схемы TL494
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схемы, то редактирование его параметров

в окне схемного редактора становится недо-

ступным. В этом можно убедиться, щелкнув

по символу элемента правой кнопкой мыш-

ки (рис. 37).

Далее запустим процесс моделирования

(рис. 38). ■
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Рис. 36. Вид отредактированного окна атрибутов

символа TL494

Рис. 37. Окно предупреждения

о невозможности редактирования

Рис. 38. Тестовая проверка модели микросхемы TL494,

созданной в виде подсхемы


